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Chapter 1 Installation and Uninstallation 

1.1 Installation  

1.1.1 SGO Recommending Installation Environment 

SGO software can be installed directly from the CD or the hard disk. It needs at least Windows XP 
OS and 1G internal storage. 

1.1.2 Installation steps 

Double click on the SGO.exe installation program and then choose installing language from the 
appearing dialog. After that the install shield wizard will detect the installation component 
automatically, then appears the interface as shown following. Click on “Next” button to continue. 

 
Then select the installation location, then the program will start to install. The installation process 
will take several minutes, please wait patiently until the installation finish. 



 
 

 
Click on “Finish” button and return to your computer desk, the SGO shortcut is automatically 
generated there. Then you can double click on this shortcut to start it, 

 



 
 

 

1.2 Uninstallation 

In this section, you will get the steps how to uninstall SGO program from your computer. This 
section provides two methods to uninstall the program. 
1, You can find the uninstalling program from Start—All Programs—SouthGNSS, then tap on 
“SGO Uninstall” option to start your operation. 

 
2. Go to “Control Panel—Uninstall a program” interface on PC server, find SGO option in 
“Programs and Features” interface, then right click on this option and choose “Uninstall” option to 
perform program uninstallation. 
Before uninstalling the program, please make sure if the software has been turned off and save all 
useful data and parameters already. 



 
 

 
  



 
 

Chapter 2 Quick Start Guide 

In this chapter, we will explain the general procedure via SGO software to resolve the data of 
static, dynamic. You can find details or advance usage in the following chapters. This chapter helps 
you to complete data processing rapidly. 

2.1 Static data processing 

SGO software can process static data in STH, Rinex format, with straightforward and simple 
operations giving you bran-new experience on your work. We will demo a process below for one 
static job surveyed in the field to show general operational procedures on SGO. 

2.1.1 Create a new project 

From the main menu of SGO, select File→New Project, or tap on the shortcut  located in 
toolbar to create a new project. 

 

Here you can define project Name and storage Location, and choose either Metric or English unit 
for your project. Click OK to enter Project Setup window, then set up the parameters for your 
current project, such as company information, coordinate system, angle and coordinate display 
format, limitation value for processing quality and so on. 
For more detail information of Project setup, please move your step to chapterⅥ Project. 



 
 

 

Click Apply to confirm all settings and click OK to finish creating new project. 
During processing, you can click Common operations→Project setting to review and modify all 
settings above. 

2.1.2 Import raw data 

Select Import→Import observation file to import all static files you want to process. SGO 

supports importing of STH files downloaded from SOUTH GPS receiver directly, or commonly-

used Rinex format. Click Open to start importing 



 
 

 
After SGO gets all files imported, it will prompt a window to show Observation period, Data 
Type, Manufacturer, Antenna Type, Antenna Height, Serial Number of the receiver observed the 
file, File storage path. Importantly, we can modify antenna height in this window for our 
observation if we didn’t set it a correct value in this field. 

 
Click OK and the graph of static network will appear. 



 
 

 

2.1.3 Baselines processing 

At the beginning of baseline process, we need to set processing parameters matching with our pre-
planned specifications for static project. Select Survey→Processing setting. 
Cal.paremeters: To set process parameters for static observation data. 

 
Cal.quality: To set tolerance for static processing. Setting listed errors smaller value means higher 
process accuracy requested for current project. 



 
 

 
Satellite: To specify data from which satellites available for static processing, supported satellites 
constellations are GPS, GLONASS and Compass. 

 
Dynamic Baseline: The settings for kinematic processing. 



 
 

 
Click OK to finish processing settings. Then click Survey→Process baseline, click Process, SGO 
will start to process all baselines in this project. 

 

If Solution type of each baseline turns to be fixed after processing, it means that all baselines are 

qualified and we can continue with network adjustment. Fixed baselines will be displayed on 

survey graph in green color. 



 
 

 
Otherwise if some baselines did not turn fixed, we have to select unfixed baseline listed in the left 
display frame, and try different groups of Cutoff angle and Interval to process this baseline again 
and get fixed solution. 

 



 
 

 
After you change the calculation parameters, you can process each baseline by right click the 
baseline in the left display frame. 

 
You can also process all failed baseline by tap on the Process failed button. 



 
 

2.1.4 Network adjustment 

Prior to network adjustment, we need to specify two or more points in static network as control 

points, and input coordinates (BLH, XYZ or xyh) of them into SGO 
In our demo project, we will specify G001 as control points. Right click each point in Station item 
in left display frame and set them as control point. 

        
Then in the right display frame select Manual input mode, then input the N,E,Elevation. 



 
 

 
If the control point only has B,L and Ellipsoidal H or XYZ, but you need the software to calculate 
the plane coordinate Northing, Easting and Elevation, you can select Projection BLH after you 
input the Geodetic coordinates, then the software will give the projection plane coordinate 
automatically. 

 
 



 
 

You can also select the As CtrlPoint option to create the control point, the different is the SGO 
software will give an approximate plane coordinate as control point, so if you do not have any 
known point, you can use this option. 

     

Click Net adjustment button , and SGO will adjust the whole network with known 

coordinates of control points. 

2.2 Kinematic data processing 

SGO program is also integrated with the ability of kinematic data processing, in this section you 
will understand well how to use SGO to perform the stop&go data processing. 
This kinematic processing method is divided into two cases, one is to process data files which 
recorded by single frequency receiver, the other one is to process the data files recorded by dual 
frequency receiver. 



 
 

2.2.1 Single frequency data processing 

The single frequency data files recorded by south H68 receiver or S750, S760 (dual frequencies 
actually) handheld which owns the ability of collecting kinematic data file, after finishing field 
data collection, download the correct raw data files from base and rover to your computer. 
 
Create a new project 
Run SGO program on computer and create a new project as same as static data processing. 
 
Load raw data 

Click import button  located in toolbar to find the folder where your data files are stored. 

Select the two kinematic files from base and rover then click ok button to go on, and modify the 
station name and antenna height in next pop-up dialog. 

 

Input control point coordinates 
After loading raw data, set the base station as control point. Right click on the base station file and 
choose “Set as control point” option, then the option of “Control point info” appears under base 
data file, tap on this option to input coordinates for base station in property window located at the 
right side. 



 
 

    
 
Data processing 

Tap on Survey—Process kinematic button   located in toolbar, click “Process” button to 
start kinematic data processing. 

 
Then tap on Close button after it finish the processing. 



 
 

 

In the Plane view all points are displayed with baselines connect to base station, if the baselines 
displays in red, that means the quality of processing is RTD, in the Station list (ViewStation list) 
view you will see the details result. 

 



 
 

 

2.2.2 Dual frequency data processing 

The difference between Single frequency and dual frequency data processing is to mark point ID 
into dual frequency data file with RW5 file from SurvCE or ppk file from EGStar. We will use ppk 
files from EGStar as an example. 
At the first, all the procedures are same as to single frequency data processing, create new project, load 
raw data files. 
 
PPK file loading 
After raw observation data files are loaded, go to “Import—Import SOUTH project” and find where ppk 
file under directory of your EGStar job folder (you should copy the whole folder of your job onto your 
computer first).  



 
 

 

 
Then you need load the CP file from the EGStar project. 



 
 

 

 
Click OK to confirm. Then you need to select the matched rover STH file. Click OK. 



 
 

 
Data processing 
Input the coordinates for control point then process all kinematic points (detail steps please refer to 
single frequency data processing). Then you will see some solutions different from single frequency data 
processing. 
If the baselines display in RED, that means the processing quality is RTD; 
If the baselines display in GREEN, that means the processing quality is FLOAT; 
If the baselines display in BLUE, that means the processing quality is FIXED. 

 



 
 

 
 
Processing result report 
After finishing data processing, go to “Survey—Report—dynamic route report” to display the 
processing result. Double click the report it can be opened by your Browser. 

 
You can also export other format go to ‘Export—Export dynamic map’. 



 
 

 
  



 
 

Chapter 3 Main Interface 

Run SGO Software from the Start menu, or directly double click on  Icon, then it enters the 

main program. As shown in following picture. 

 

Create a new project or open an existing project, you will get the toolbar activated and the entire 
menu bar, and the other corresponding windows. Please see the following picture, menu bar and 
toolbar are located at the top of main interface, and the project explorer window is located at left 
side, on the contrary, there is the property window. 
 
 

 

Menu bar: The list menu is an important part of any type window. It supplies many command to 

Menu bar 
Toolbar 

Property management 
Project management 

Display window 

Message output window 



 
 

create engineering files, resolve data, and manage data. 

Tool bar: It provides majority common shortcuts for fast operation. And the corresponding 
command can be found in menu. 

Display window: It is the user’s main working field, generally includes every type views 

related to project. 

Project Explorer: Users can browse all the observation data and baseline information here. 
Message Output window: Output message of processing. 
 

3.1 Menu  

The main menu of the program consists of File, Common operations, View, Survey, CAD, Tool, 
Every menu item has a window shortcut key located in toolbar. The menu items provide the 
operation to complete most of the data processing work and cover the main processing steps. 

 

3.2 Toolbar 

You can achieve the main operations through the Toolbars in the main program. It includes create 
new project, open project, project setting, import data, export data, adjust the work field, process 
the baseline, check report. 

 

 

3.3 Project Management 

The Project Management window is placed at the left of main interface. It is used to manage all 
context of the project, including points list, baselines list, and observation files list. Click on “ ” 
symbol to open the corresponding contents, for example, click on “ ” symbol before the station 
to view relative data file to the point. Tap on the file, you will have the relative information 
displayed at property window such as Point info, Geographical latitude and Cartesian coordinate. 



 
 

 

3.4 Display window (Plan View) 

This is the important working window of main interface which mainly displays the added 
information such as site list, baseline, scale, and grid etc. 



 
 

 

3.5 Property window 

The property window will display the different properties according to the selected node in project 
management, if a point is selected, the corresponding information is displayed in property 
window, as shown the left in following pictures. 

             
Station properties                               Baseline properties 



 
 

3.6 Output window 

This window is mainly used to display the message of your operation, for example, if the 
kinematic data is processed, it will display as “All kinematic points processed”. If the operation is 
on static data processing, it will display as “All baselines processed”. 

 
  



 
 

Chapter 4 File 

This chapter provides information on using main commands from File menu, including New 
project, Open project, Project setting. 

 

4.1 New project 

This command is used to create a new project for data processing at the beginning of starting job. 
To create a new project, click on this command then the new project window will be pop-up, then 
requires you to choose the unit, input a project name and set up the project saving path. 



 
 

 

Click “Browse” button to control where the project is saved by browsing to the desired folder 
where the job is to be created, then select OK button to continue. 
 
Then set up the parameters for the project in such a following window, input general information 
including company information and operators. 

 



 
 

Go to “Coordinate system” tab to set up your local coordinate system and check if the parameters 
are correct. Click on the Predefined button to choose the country or region from predefined list, 
then choose the correct coordinate system at the next field at the right side of coordinate system.  
If your local coordinate system is not listed under predefined list, you are able to click on 
“Coordinate system manager” button to self-define your local coordinate system at coordinate 
system manager (please take a reference to Coordinate system manager for more detail 
information about how to create a coordinate system) 

 
The “Unit options” tab allows you to configure the unit and the precision for general items such as 
coordinate, distance and angle, as well as the format of coordinate, you can set the coordinate to 
display as spatial coordinate, geodetic coordinate or plane coordinate. 



 
 

 
Move to “Closure loop tolerance” tab, this is allowed to control the quality of processing result, 
choose the predefined standard from the list of specification name, or choose user defined option 
to re-configure the parameters according to your requirement. 

 
The “Export setting” tab is used to configure what kind of solution result and what kind of fields 



 
 

of points to output in reports. 

 
At the last tab of “Dynamic View”, this is allowed to enable or disable what kind of dynamic data 
solution to view, or if enable to view the baselines between points, and whether to display the PPK 
base station. 

 



 
 

After all the parameters for the project are configured, click OK button to finish creating a new 
project, then you will enter the main interface of SGO. As shown in following figure. 

 

4.2 Open project 

This command is used to open an existing project which is saved for previous job. 
Click on this command to browse to the folder where the project file is located, then choose the 
project file with the .sgo file extension and then click “Open” button to load the data. 
(If a project is saved, the .sgo file extension will automatically be appended to the file name) 



 
 

 

 

 

4.3 Project setting 

This “Project setting” allows you to set up the parameters or re-configure parameters for your 
current project. 
At the beginning of starting your project, SGO asks you to set up parameters for project first when 
you create a new project. After that you can check and modify the parameters from project setup. 



 
 

 

4.4 Close 

To close the current project, tap on Yes to confirm, No to cancel it. 

 

4.5 Save 

Save the current project to default path. 



 
 

4.6 Save as 

Save the current project to user defined Path. 

 

4.7 Print  

To print the plane view picture. 

 



 
 

4.8 Options 

This button is for changing the project default settings. 

4.8.1 Show 

Here you can change the software interface color and if shows the display mark and grid. 

 

4.8.2 Save 

Here you can edit the project default save path. You can tap on the Restore default setting to 
restore the software default save path, it is under Documents folder in you PC. 



 
 

 

4.8.3 Port 

This port is for the Cloud service settings. 

 



 
 

Chapter 5 Common operations 

Common operations provide the common used button for Project, Data processing, PPK and view. 

 
All this function will be shown in other related chapter. 

5.1 Toolbar edit 

Right click the toolbar, it will appear a window. 

 
 
Tap on Customize Quick Access Toolbar.., in this interface you can add or remove the button 
inside Quick Access Toolbar. 

 



 
 

 
Click Show Quick Access Toolbar Below the Ribbon button, the new toolbar will appear, if you 
want to close it, just click this option button again. 

 

 
Click Customize the Ribbon…option, in this window, you can edit the options in menu bar and 
toolbar. 

 
For example, I create a new group under Common operations and named Export, then I add the 
Export function into this group, Click OK to confirm. Then I can see a new export button under 
Common operations. 



 
 

 

 
 
Tap on the Minimize the Ribbon option, the whole toolbar will be hidden. 

 

 
  



 
 

Chapter 6 View 

This chapter provides more information on using commands under View menu, in this chapter we 
emphasis on some important commands including toolbar, station list, station edit, station 
occupation, residual analysis, baselines list, repeated baselines list, closure loops list.

 

6.1 Window settings 

The left three buttons control the project management window, properties window and log 
window display or not. 
 

 

 

Project management  

Properties window 

Log window 

Project management window 

Log window 

Properties window 



 
 

6.2 Plane view tools 

This tools is for adjusting the plane view window display method. 

 
The detail instruction of each shortcut is described in following table: 

Items  Function  Description 

 
Move 
 

Move the map 

 
Zoom in Zoom in the view 

 
Zoom out Zoom out the view 

 
Partial enlarge Zoom in the specific area 

according to the selection 

 
Zoom all Zoom all the view 

 
Anticlockwise rotate Rotate the map anticlockwise 

 
Clockwise rotate Rotate the map clockwise 

 
Reset  Restore the default map 

direction  

 
Properties  Switch the move function to 

selection function 

 
Homepage  Open the homepage window 

 

6.3 Plane view  

Here you can enable or disable the online map display or not. 



 
 

 

6.4 Station list 

This means the station list, after finishing data processing, click on this option, all the stations will 
be listed in this window accompany with processing quality and coordinates. 
Click on each tab to sort stations or values. If you want to change the coordinates display format, 
please go to “Common operations—Project setting—unit options—Coordinate format”, select the 
format to display as you want. 

 



 
 

 

6.5 Station edit 

This is the station session that allows you to check quality of satellites’ signals. Before processing, 
you can check the satellites’ signals first and edit to erase some bad signals to make sure the 
quality of data processing. 
Draw a frame on bad signal section and choose forbid option in the pop-up dialog to erase this part 
signal. 

 

6.6 Station time 

Click on this command to check the common observation time of stations. 



 
 

 

6.7 Residual analysis 

The Residual analysis command allows you to check the residual error of each baseline, there you 
will get the information of residual error of each satellite including the maximum and minimum 
error, and the value of standard error and the average error. 

 

6.8 Baselines list 

This baselines list is used to display the information of all baselines after finishing baselines 
processing. 
Click on this command, you will then get into the baselines list window and obtain all 
corresponding information including component for each baseline, fixed ratio, RMS and baseline 
length. 



 
 

 

 

6.9 Closure loops list 

After baseline processing, click on closure loops list option to view all closure loops. In loops 
page, all the closure loops are listed accompany with their corresponding information, such as 
loop type, the quality of processing result, closure error of each variable (XYZ and side length), 
length and relative error. 
Tap on the “ ” symbol before the closure loop, you will understand this closure loop is 
composed by which 3 baselines including the result of processing. 
Type: this field is to show you what type this closure loop belongs to, generally, the synchronous 
loop is the most common loop. 
Quality: this field will display the processing result for this closure loop and the baselines which 
form this loop. If the baselines turn out to be fixed, the result of quality of closure loop is shown as 
pass, that means the closure loop is qualified. 
Closure error (DeltaX/ DeltaY/ DeltaZ/ DeltaS): this is the difference value between the 
observations and due value. 
Length: it is the perimeter of closure loop. 
Relative error: this error is the ratio between absolute error caused by measurement and the true 
value of measurement (agreed), in general, the relative error can reflect more the credibility of 
measurement. 

 



 
 

  



 
 

Chapter 7 Survey 

In this chapter we emphasis on some important commands including baseline process settings, 
baseline processing, kinematic processing, net adjustment and some hiding commands.. 
 
This chapter provides more information on using commands under Report menu, in this chapter 
you will well know how to make a report for your data processing result. 

 

7.1 Import and export  

This two buttons are used to load observation raw data for your current project such as Static or 
Kinematic. Static raw data loading and kinematic data loading are similar to each other, but there 
is still a little bit difference between each other. Detailed information please refer to Chapter2. 
 

7.2 Download IGS  

The Download IGS function only can be used with Kinematic data, after the users import the 
kinematic data collected, the Download IGS button will be activated, click this button, the SGO 
will download the nearest IGS station static data for users to process the kinematic data together. 

 



 
 

 

 
Note: If you already have the base station data for post processing, you do not need to load the 
IGS data anymore. 
 

7.3 Processing setting 

There are four pages in this dialog, including Cal.parameters, Cal.quality, Satellite, Dynamic 
baseline. 



 
 

7.3.1 Cal.parameters 

 

Least epoch in section: For static survey, if the observation epoch is less than 30, the observation 
data can’t form baseline. 
Circle slip detection method: There are two options for detecting circle slip, TD and Kalman. 
Mask angle: Cutoff angle is used to limit the satellite data with relatively lower elevation angle, 
these data won’t be processed when you processed baseline. 
Usually the signal quality of satellite with low elevation angle is very bad, so when we process the 
baseline, we can adjust this parameter to forbid this kind of data. 
Sampling Interval: it means epoch interval which is involved to baseline processing, that is to 
say, if you set sample interval to 5s, the receiver will collect 12 epochs in 1min, but when you set 
interval to 10s in baseline setup, it means only 6 epochs will be taken to baseline processing in 
1min. but notice that, the interval must be bigger than sampling interval, otherwise, the setting will 
be invalid. 
Fixed rate: this parameter refers to baseline qualified condition, usually, the default value is 
3.0,after processing, if the result is bigger than 3.0, the baseline is qualified, otherwise ,it’s failed. 
Enable GPS: True means using GPS data, False means not. 
Enable GLONASS: True means using Glonass data, False means not. 
Enable BDS: True means using Beidou data, False means not. This function is only available in 
registration version. 
Solution type: there are 4 options,L1/B1,L2/B2,Ionosphere-free combination,L5/B3. For short 
distance, L1/B1 method is recommended.  



 
 

Estimate troposphere or not: True means using troposphere error, False means not. 

7.3.2 Cal.quality 

 
Single frequency fixed error: the default value is 0.03, if the result is less than 0.03, the baseline 
is qualified, otherwise it’s failed. This is suitable for single frequency observation data. 
Single frequency ratio error(ppm): the parameter is used to estimate repeated baseline error and 
closure loop error, the default value is recommended. 
Dual-frequency fixed error: the default value is 0.02, if the result is less than 0.02, the baseline is 
qualified, otherwise it’s failed, this is suitable for dual-frequency observation data. 
Dual-frequency ratio error(ppm): the parameter is used to estimate repeated baseline error and 
closure loop error, the default value is recommended. 
 



 
 

7.3.3 Satellite 

 
This page is used to control the satellite which can involve to baseline processing or cant, user can 
check or uncheck satellite number to control it. GPS, GLONASS, BDS are available. 

7.3.4 Dynamic Baseline 

This is configured some settings for kinematic processing. 
 



 
 

 
 

7.4 Process baseline 

Before baseline processing, we can check observation point data quality. From the project 
management, click observation file you will see the station edit interface. 



 
 

 
Right click observation file, select quality check, it will pop-up a new dialog, quality check 
result. 

 

There are two pages in the dialog, quality check result, view. 

7.4.1 Quality check result 

This is a detailed report about observation data quality. If the data quality is too bad, the result will 
show Failed, if it’s qualified, the result is Pass. The report also includes observation satellite 
number, observation epoch, data completeness and so on. According these information, we can 
basically judge the data quality condition. 



 
 

 

7.4.2 View 

There are five options in this page, skyplot, Nsat, multipath, elevation,azimuth,SNR.  
Skyplot 

 

It shows every captured satellite running orbit during observation time. 
Nsat 

 

It shows captured satellite number during every time span. 
Multipath 



 
 

 

This page shows multipath effect, includes L1 and L2 multipath. 
Elevation  

 

This page shows all captured satellites’ elevation orbit.  
Azimuth 



 
 

 

This page shows all captured satellites’ azimuth of orbit. 
SNR 

 

SNR means signal to noise ratio, it’s an index to estimate satellite quality. This page shows all 
captured satellites SNR condition change as time goes on. 
 
 

After making above checking and setting, we can click  button on the toolbar. Then you will 
see the following figure, 



 
 

 
If you want to process specified baseline, you can just select the baseline you want to process. Or 
you can directly press Process button to process all baseline. 
After processing procedure finished, if the baseline is qualified, the solution type will be fixed, 
ratio will be bigger than 3.0, and RMS will be smaller than 0.02. 
Ratio 
The RATIO is the rate of the less least RMS and the Least RMS after the integer ambiguity 
analysis, that is: 

 
It reflects the reliability of the integer ambiguity parameter, which is determined by a few factors. 
It has the relation to the observation quality and the observation term. The RATIO is the key to 
reflect the quality of the baseline, generally, the RATIO is required to bigger than 3. 
RMS 
RMS is the Root Mean Square, that is: 

 
V is the residual of the observations. 
P is the weight of the observations. 
n-f is that the total numbers of observations subtracts to the number of known number. RMS 
means the quality of the observations. The smaller the value of RMS is, the better the quality will 
be. Otherwise the worse the quality will be. The RMS is not effected by the observation terms. 
According to the theory of Symbolic Statistics Mathematical Statistics, the rate of the observation 
error within the 1.96 times of RMS is 95%. 



 
 

 
If all the baselines get fixed solution, you can press Close button to Save the processing result and 
exit. 

7.5 Adjust failed baseline 

But in reality, it’s impossible to make all baselines to get fixed solution at the first time, some 
baselines may get float, dgps or none result. In that case, we should adjust parameters to reprocess 
the baseline again, sometimes, the operation will repeat again and again. See the below example, 

 
Firstly, we should save the result, then the baselines with fixed solution will be saved, we just need 
to reprocess unqualified baseline. 



 
 

 

The qualified baseline will become green, unqualified baseline will become red. Then we can 
select unqualified baseline one by one by clicking the red baselines in plane view workspace, the 
selected baseline will become blue. The right workspace will show baseline information. 

 

The right bottom corner shows current process parameters, we can adjust the following parameters 
to reprocess it. 
 
1. After checking the observation data, we can see the sampling interval is 5s, but the default 

processing interval is 30s, so we can adjust processing interval to 5s, so the involved epoch will 
become more. After change to 5s, we can click the Process failed button to reprocess the failed 
baseline, 



 
 

 
                               Before reprocessing 

 
                              After reprocessing 
 

2. Also you can adjust cutoff angle, using GLONASS, and select different solution type to try to 
reprocess the unqualified baselines. 

3. If above methods still can’t get satisfied result, we can check the baseline residual condition, 
For example, after above processing, there is only left one baseline which is unqualified. 



 
 

 

We can check the baseline report by clicking reportBaseline report button, select baseline in the 
left Project management window. Then it will pop up a new dialog, 

 

From the chart, we can check the residual, usually the normal residual error is only 20-40mm 
grade. If any satellites qulity is not good, we can try to forbid the satellite observation. 



 
 

 

Finally, if you still cannot get the qualified solution, you should prevent this baseline from the 
network adjustment or delete this baseline. If the baseline is necessary in the control network, you 
should resurvey this baseline. 

7.6 Delete baseline and rebuild baseline 

If you want to delete specified baseline, you can tap it in the plan view workspace, then right-click 
mouse, and select the Delete item. 

 

If you delete by mistake, you can click Rebuild baseline button to regenerate it again, this 
function is for regenerating all delete baseline, then you need to process the rebuild baseline again. 



 
 

7.7 Kinematic processing 

Kinematic processing is used for kinematic survey, stop& go survey. The progress is very simple, 
we can view previous quick guide. 

 

The baseline color means different result, blue means fixed, green means float, red means dgps, 
grey means single. 
After processed, you can click View->Station list to check kinematic points result. 

 



 
 

7.8 Network adjustment 

7.8.1 Network adjustment type 

There are 4 kinds of network adjustment, 3D free network adjustment, 3D restricted network 
adjustment, 2D network adjustment, and level fitting. 

 
In SGO software, if you don’t input known BLH coordinate as control point’s coordinate, the 
software will automatically select the first point as control point, if you want to make whole 
network adjustment, you should input one NEH coordinate at least. 
 

7.8.2 Step of network adjustment 

In SGO software, network adjustment step is very simple, 



 
 

 

1. Just select the control points in project explorer workspace, right-click the point name, select 
Set as control point option. 

2. Click Control point info item. The right workspace will pop up coordinate information field. If 
your known point coordinate format is space coordinate, you can input it to XYZ field, if you 
known point coordinate format is BLH, you can input to BLH field. The last filed is suitable 
for NEH coordinate. 

3. Then click Net adjustment to make network adjustment. 
 

7.9 Report 

Report button contains Baseline report, Baseline list report, Closure loop report, Net adjustment 
report, Dynamic route report, Quality check report, 3D adjustment report, 2D adjustment report 
and closedloop report. 

  

7.9.1 Baseline report 

It show single baseline quality report, includes common satellites condition and residual error 



 
 

information, before press the menu, you should select specified baseline in project management 
workspace.   

 
 

7.9.2 Baseline list report 

It shows all baselines solution type, RMS conditions. 

 

 

7.9.2 Closure loop report 

It shows the closure loop X, Y, Z component closure error and side closure error. 



 
 

 

7.9.3 Net adjust report 

It’s used to show network adjustment result.

 

7.9.4 Dynamic route report 

This report is used to show kinematic point result, includes point coordinate and solution type. 



 
 

 
 

7.9.5 Quality check report 

It is used to show all repeated baseline and closure loop condition. 

 



 
 

7.9.6 3D adjustment report 

It shows the 3D adjustment result. 

 

7.9.7 2D adjustment report 

It shows the 2D adjustment result. 

 



 
 

7.9.8 closedloop report 

It shows the closure loop result in txt file. 

 
  



 
 

Chapter 8 CAD 

 
This chapter will introduce the CAD function in SGO, it is a useful function to help draw simple 
map base on the collected points. It also provide other function like angle and distance 
measurement, are and volume measurement. 

8.1 CAD tools 

8.1.1 Draw point 

With this tool, users can draw a point on the map, click the position you want to draw it, in the 
right work space you can input the point name and point color, after check the point coordinates in 
the bottom, click Create button to confirm drawing or Close button to cancel it. 

 

8.1.2 Draw polyline 

With this tool, you can draw polyline on the map, left click the mouse to select the trace of the 
polyline, right click the mouse to finish the drawing. Then you can input the polyline name and set 



 
 

the line style, width and color in the right work space, after check the point coordinates of the 
polyline, click Create button to confirm drawing or Close button to cancel it. 

 

8.1.3 Draw polygon 

With this tool, you can draw a polygon, left click the mouse to select the trace of the polygon, 
right click the mouse to finish the drawing. Then you can input the polygon name and set the line 
style, width and color in the right work space, after check the point coordinates of the polygon, 
click Create button to confirm drawing or Close button to cancel it. 

 



 
 

8.1.4 Draw text 

With this tool, you can input text on the map, left click the mouse to select the position of the text. 
Then you can input the text name and set the text color and font in the right work space, after 
check the point coordinates of the text, click Create button to confirm drawing or Close button to 
cancel it. 

 

8.1.5 Draw circle 

With this tool, you can draw a circle, left click the mouse to select the center of the circle, move 
the mouse to set the radius, click the mouse to finish the drawing. Then you can input the circle 
name and set the line style, width and color in the right work space, after check the point 
coordinates of the circle, click Create button to confirm drawing or Close button to cancel it. 



 
 

 

8.1.6 Draw arc 

With this tool, you can draw a arc, left click the mouse to select the center of the arc, move the 
mouse to set the radius, click the mouse to set the start point of the arc. Then click the mouser 
again to set the end point of the arc. Then you can input the arc name and set the line style, width 
and color in the right work space, after check the point coordinates of the arc, click Create button 
to confirm drawing or Close button to cancel it. 

 



 
 

8.1.7 CAD edit 

 
The SGO also provide CAD edit function like properties check, delete, delete all, undo and redo 
function. 
After click Properties button, you can select the CAD shape in the map. Then you can edit it with 
other edit tools. 

 

8.1.8 COGO 

COGO provide tools to measure the Angle, Distance, Area and Volume. 



 
 

 
  



 
 

Chapter 9 Tool 

9.1 Coordinate system 

Coordinate system management contains the majority of countries’ and area’s common used 
coordinate system, you can click on this command to check, edit, create new coordinate system. 

 

9.2 Coordinate conversion 

With Coordinate conversion tool, you can convert original coordinates no matter geodetic 
coordinates, Cartesian coordinates or plane coordinates to destination coordinates under same or 
different coordinates system. 



 
 

 

9.3 Antenna management 

Antenna management is designed for updating and editing the receiver parameter file. When you 

used an unknown receiver type but you have the geometric parameter of the receiver and the phase 

center height parameters, you can use this tool to add the receiver you as need. 
Click Antenna management button, there will be pop-up the antenna manager window, you can set 
up some commonly used parameters here, such as the radius, the phase center height 



 
 

 
In the list window, double click the name of the antenna, you can change the corresponding 
parameters directly. 
You can create a new antenna parameters by tapping on New button, you can also import the .atx 
antenna file from NGS website directly by Import button. 

9.4 Road design 

Road design tool is used to design a road file for field road stakeout. 

 



 
 

9.5 Instar 

InStar is a multi-functional setting tool, which can perform data transfer, firmware upgrades, 
parameter settings, radio settings, network settings, mainframe register. This tool is simple and 
easy. Install InStar to the computer 
   Perform “Data Output” and “Parameter settings” via USB port； 
   Via serial port, the function options are “Radio Settings, Network Settings, Receiver 

Register. Both can do firmware upgrades; 

 

9.6 GPSdecoder 

GPSDecoder software is used to debug the receiver module, you need to connect the receiver to 
PC by RS232 port. Select the correct port and baud rate, then you can receive the output message 
from the receiver and you can also send command to the receiver module. 



 
 

 

9.7 Quality check 

This tool is used to check the single static data quality, we often use this tool to analyze the 
collected data from where should be a reasonable position for CORS station. 

 

9.8 Data template 

This is a tool to create GIS collection data dictionary which can be imported to SOUTH GIS data 
collector software GIStar. More information please refer to the GIStar manual. 



 
 

 

9.9 Export Rinex 

With this tool, you can convert the different format static data into different version Rinex data. 

 



 
 

9.10 RTK check 

This function is allowed to compare the result between your RTK points and the kinematic points. 
At the meantime of your RTK job, you can save the kinematic raw data and process it in office, 
then check the difference of RTK points and kinematic points. 

 

9.11 Software registration  

Click software registration button, it will appear a new window then click Upgrade Account 
button appear another window which shows the serial number of the SGO in the local PC. Users 
need to send back the serial number to the provider and ask for a registration code. The advanced 
functions are just supported in registered version SGO. 
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